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Flying Colors 1.1
Windows allows you to set the colors of various objects. However, the colors must be 
chosen from a fixed palette of 16 (or 20) colors which may not be changed.

Flying Colors 1.1 is a Windows add-on utility that lets you easily change those palette-
colors to anything you like. Color configurations may then be saved as .FLY files which may
be loaded at any time.    

Flying Colors includes a built-in brightness (dimmer) control, a contrast control and several
complexion (tint) controls.

Requires Windows 3.1 or higher.

See also:
License
Registration



Installation
Flying Colors' Files
Choose a directory where Flying Colors will reside.
Copy the files:
    FLYINGC.EXE
    FLYINGC.HLP
    *.FLY
to that directory.    The other files are optional and may be deleted.    However, you might 
like to save README.TXT and/or ORDER.TXT for future reference.

Adding a Flying Colors icon to Program Manager
In Program Manager, click the "File" menu option, then "New", then select "Program Item" 
and enter FLYINGC.EXE with its full path as the new item.    It is recommended that you add
Flying Colors to your    "StartUp" group.    This will cause Flying Colors to run every time 
that Windows starts up.
A similar procedure may be employed to add Flying Colors to a different Windows shell 
than Program Manager.

Running Flying Colors
Info on Running Flying Colors

Uninstalling Flying Colors
Delete the files:
    FLYINGC.EXE
    FLYINGC.HLP
    *.FLY
    README.TXT
    ORDER.TXT
from the Flying Colors directory.

Delete any icons that you may have added to Program Manager (or other Windows shell).



Registration
Flying Colors may be registered by mail.    Flying Colors may also be registered online by 
Compuserve users by GOing SWREG (Registration ID 5505).

Upon receipt of your $15 payment, you will be supplied with a "Validation Code".    This 
code is entered exact;ly into the program along with the "Registration Name" of your 
choice.    The "Registration Name" and "Validation Code" are entered by selecting 
"Register" from the    main menu of the Flying Colors main window.

Benefits of registering Flying Colors
No more nagging.

Your "Registration Name" will appear in place of UNREGISTERED!! on the Control Panel.

The main configuration window can be sized even smaller.

Upgrades will ALWAYS be free to registered users.    Future versions will be made readily 
available for download.    You should be able to find them the same place you found your 
current copy of Flying Colors.

Suggestions by registered users will be incorporated into future versions of Flying Colors.

Registering supports the try-before-you-buy shareware system.

Accessing the Order Form
Click on:
Order Form

Or print the file ORDER.TXT which is included with the Flying Colors distribution package.

If you do not have a printer, be sure to include all of the information requested in the order
form with your check or money order.



Hints/Problems
Limitations

Flying Colors works properly with MOST but not all Video Drivers.    The program attempts 
to detect if it is working with a compatible driver but it is possible that it will fail to detect 
an incompatible driver.    In such a case, the program will not set the system colors 
properly and should not be used.

Sometimes if Windows is running in 256-color mode, the colors on the screen may 
temporarily flash to the original Windows settings.    This is because some program has 
reset the palette.    Flying Colors will reset the colors to your preferred configuration as 
quickly as possible.    If Flying Colors does NOT reset the colors, refer to "Potential Problem 
#1" below.

Flying Colors only effects the so-called Windows system-colors.    This is a palette of 16 (or 
20) colors which are used to display windows, controls, menus, etc.    When running in 256-
color mode, some programs (like .GIF viewers) will probably use additional unaffected    
colors    to display their images.

Potential problems
Problem 1
My system-colors revert to their original shades even whileFlying Colors running.
Solution 1
Turn on AutoUpdate. For more info, see:
Auto Update option

Problem 2
Flying Colors interferes with the operation of some other program.    Great care has been 
taken to prevent such a problem ... however, in the unlikely event that Flying Colors 
degrades the performance of another program, try the following solutions in order of 
preference:
Solution 2a
Turn off AutoUpdate (if not required for Problem 1).
Solution 2b
Add the line:
UpdateMethod=2
to the [Options]    section of FLYINGC.INI in your windows directory.    Then, exit and restart 
Flying Colors. This will probably only have an effect if running in 256-color mode.
Solution 2c
If Solutions 2a and 2b don't fix the problems, the Auto Update option must be toggled 
manually.    Turn off Auto Update before running the problem-program and Turn Auto 
Update on whenever the system-colors revert.    This option may be toggled from the 
Flying Colors running-icon (if visible). For more information, see:
 Auto Update option
Solution 2d
Please contact Natural Software Company for assistance.
 P.O. Box 217, Haleiwa, HI    96712-0217
 72672.3476@compuserve.com



COMMDLG.DLL required
COMMDLG.DLL is required to "Load File ..." and to "Save to File as ...".    If Flying Colors 
crashes attempting to perform one of these operations, it is probably because 
COMMDLG.DLL is missing.    This file should be in the windows \SYSTEM subdirectory.    If it 
is not, it is probably available on the installation disks for your version of Windows.
More info about Load File ... and Save to File as ...

Known bugs
None at present.



Flying Colors Order Form
 
Ordering Information
(Each copy of Flying Colors 1.1 is licensed for one computer)

      ____    copies at $15(US) each                      =_____________

Discount (see below)                        -_____________

SubTotal                      =_____________

Hawaii residents add 4% GE tax                      +_____________

Total payment enclosed                      =_____________
 

Mailing Information ...
 
Name_________________________________________________________
 
Company______________________________________________________
 
Address_______________________________________________________
 
City______________________                      State/Region____________

      Postal/Zip Code__________                      Country_________________

    
... and/or Internet Address

Internet address____________________________________

Registration Name
 
NAME as it will appear on your copy (copies) of Flying Colors
 
Copy 1 ___________________              Copy 2 ___________________
 
Copy 3 ___________________              Copy 4 ___________________
 
Additional copies: attach separate sheet

---------------------------------------------------------------

A copy of this page may be printed by    clicking on the "File" menu item of this window and
then    "Print Topic".

Flying Colors may be registered by Compuserve members online by GOing SWREG 
(Registration ID 5505), In order to register by mail, fill out the above form and mail with 



your check or money order to:
 
      Natural Software Company
      P.O. Box 217
      Haleiwa, HI      96712-0217
      USA
 
Checks must be in US dollars drawn on a US bank.    International postal money orders in 
US dollars may be used.        Postage to Hawaii is the same as to everywhere else in the 
United States.
 
Each purchased license of Flying Colors is valid for one computer.
The following discounts are available:
$100-$499                10%
$500-$999                20%
$1000 +                          30%
Contact us about network site-license prices.



License Agreement
License
This program is shareware.    You may use the program and evaluate it for no more than 30
days.    After this time, you must either register Flying Colors or remove it from your    
system.    By using Flying Colors, you agree to these terms.    Failure to comply with this 
condition is a violation of U.S. and international copyright law.

Distribution
You may freely (in fact, you are encouraged to) copy and distribute copies of the archive 
file as FLYCOL11.ZIP so long as:
1) no files are added or deleted from the archive
2) no files in the archive are altered

Disclaimer
This software and the accompanying files are provided as-is. There are no warranties 
express or implied.    Any liability of Natural Software Company shall be limited to refund of
the product purchase price. Natural Software Company is not responsible for any problems
or damages that may result from using the software.



Starting Flying Colors
There are several ways to run Flying Colors.    A Program-Manager icon may be associated 
with any of these forms.

1) path\FLYINGC.EXE
2) path\FLYINGC.EXE filename.FLY
3) filename.FLY

The first form simply starts up Flying Colors ... if a Default File was specified, it will be 
loaded. The second and third forms start up Flying Colors and load filename.FLY as the 
Current File.    For more information on .FLY, Current Files, and Default Files, see:
Files

The program may initially be run minimized by setting the Run Minimized option from the 
Options menu.    The program may be run hidden (Registered users only) by setting the 
Run Minimized and Hide Icon options.    For more information on options, see:
Options

In order to make Flying Colors visible when it is hidden, simply start up another instance of
the program using any of the 3 forms given above.    This will make the Flying Colors 
window reappear and will cause a .FLY file to be loaded if appropriate.



Files
These functions are available by choosing Files from the menu across the top of the main 
control panel. .

Flying Colors' colors schemes may be saved in .FLY files.    These files, once saved may be 
loaded at any time.    The file which is specified as the Default-File is loaded when Flying 
Colors starts running.

If you think you have a really good .FLY file, please put it on a 3.5 inch floppy and mail it 
to:
Natural Software Company
P.O. Box 217
Haleiwa, HI      96712-0217
A selection of really good .FLY files will be distributed with future versions of Flying Colors.   
Authors will be credited.

Load File ...
Load a .FLY file from disk.    The colors in the file will become the current colors.    The file 
becomes the Current File.

Reload <filename>
The Current File will be reloaded from disk.    Any changes made to the colors will be lost.    
This function will be grayed if:
1) There is no Current File
2) There have been no color changes since the Current File was loaded

Save to File as ...
Save the current colors to disk as a .FLY file.    The filename chosen becomes the Current 
File.

Save <filename>
Save any changes to the Current File back to disk.    This function will be grayed if there 
have been no color changes since the Current File was loaded.

Load <defaultfile>
Loads the Default File from disk.    See below on how to set the Default File.

Set <filename> as default
Sets the currently loaded file as the Default File.    The Default File is loaded whenever 
Flying Colors first starts up.    The Default file may be set to <none> if no file is currently 
loaded.    The Current File may be unloaded by choosing the Restore Original Colors option 
from the Options menu.



Options
These options are available by choosing Options from the menu across the top of the main
control panel.    Options that are checked are in effect.

Start Minimized
The program will be initially launched in iconic form.

Hide Icon
The program will be invisible when minimized.    This option is only available to registered 
users.    If Flying Colors is invisible, it may be made visible again by starting-up another 
instance of the program.

Describe Buttons
There is a toolbar of    buttons on the main control panel.    These buttons mimic the 
functions of many of the available menu options.    If the "Describe Buttons" option is in 
effect, a brief description for the function of each button will appear whenever the mouse 
passes over that button.    This option is very useful to new Flying Colors users and very 
annoying to experienced ones.

Auto Update
 It is recommended that this option remain DISABLED (unchecked) until    a need to enable 
it is determined. Normally, Flying Colors will update the system-colors any time it senses 
that the system-palette has been changed.    Occasionally, another program might manage
to change the system-palette without Flying Colors knowing about it. If this happens, the 
system-colors will probably revert to their original shades. Turn on Auto Update for 
automatic periodic updating of the system-palette.
For more information see:
Problems/Hints



Colors
These functions are available by choosing Colors from the menu across the top of the main
control panel.

Edit Colors
displays the    Edit Colors window

Restore Original Colors
This unloads the current .FLY file (if any) and restores Windows' colors to their original 
default settings.      The same effect may be achieved by hitting the Esc-key. 

Brightness Control
This might also be called a Dimmer.    Selecting Brightness Control    allows adjustment of 
the    brightness of all Windows system-colors.    While adjusting the brightness, hitting the 
Esc-key exits the Brightness Control and restores the Brightness to its original setting.

Contrast Control
Selecting Contrast Control    allows adjustment of the Contrast of all Windows system-
colors. While adjusting the brightness, hitting the Esc-key exits the Contrast Control and 
restores the Contrast to its original setting.

Tint Controls
Selecting a Tint Control    allows adjustment of the complexion of all Windows system-
colors. While adjusting the tint, hitting the Esc-key exits the Tint Control and restores the 
Tint to its original setting.    For more information about Windows colors, see:
Edit Colors



Edit Colors
Windows Colors primer
Windows makes colors by combining light.    The primary colors of light are red, green and 
blue.    All other colors are combinations of these 3:
Cyan (Aqua) = Blue + Green
Magenta (Purple) = Red    + Blue
Yellow =    Red + Green
White = Red + Green + Blue
Black = <absence of all colors>

Thus, the following pairs are opposites:
White <--> Black
Cyan <--> Red
Magenta <--> Green
Yellow <-> Blue

The Color Buttons
Clicking one of these colored buttons (on the left side of the window) chooses which color 
will be edited.    Clicking on the large, multicolored button edits all colors simultaneously.    
The large box (to the right) shows which color is being edited.

The Red,Green,Blue,All    sliders
The Red, Green and Blue sliders control the amount of red, green and blue    that will be 
contained in the Color being edited.    Manipulating the All slider is like manipulating Red, 
Green and Blue simultaneously and has the effect of controlling the "whiteness" of the 
Color being edited.    Remember that hitting the Esc-key aborts the Edit Colors session and 
restores everything to its original setting.    This is very useful if the colors get so messed 
up that it's not possible to locate the Cancel button.

Reset Color(s) Button
Clicking this button resets the currently selected color to what it was when you started 
Editing Colors.    If the multicolored button is selected, all colors will be reset.



The Control Panel
This is the main window for Flying Colors.    It contains a menu, a button toolbar, and 
displays the name of the currently loaded .FLY file.

Menu items
File
Colors
Options
Register

Toolbar
There is a toolbar of    buttons on the main configuration panel.    These buttons mimic the 
functions of many of the available menu options

Accelerator Keys
The following keys are in effect for the main control panel:
Esc ...    restores the original Windows color-scheme 
B or Control-B ... displays the Brightness (dimmer) control
E or Control-E ... displays the Edit Colors window
C or Control-C ... displays the Contrast control
F1 ... provides help

Additional System-Menu items
These items are added to the system-menu.    Their main use is that they are available 
from the running-icon:
Brightness ... displays the Brightness (dimmer) control
Contrast ... displays the Contrast control
Edit Colors ... displays the Edit Colors window






